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MENUS
Includes Demonstration Program MenusPascal

Introduction

Types of Menus

A menu is a user interface element which allows the user to view, or choose from, a list of choices and
commands provided by your application.  There are basically three types of menus:

• Pull-Down Menus.  A pull-down menu is identified by a menu title in the menu bar.  Each
pull-down menu comprises a menu title and one or more menu items.

• Pop-Up Menus.  A pop-up menu is a menu which does not appear in the menu bar but rather
appears on another part of the screen when the user presses the mouse button while the cursor is
at a particular location.  Pop-up menus are generally located within dialog boxes.

• Submenus.  A submenu is a menu that is attached to another menu.  A menu to which a
submenu is attached is referred to as a hierarchical menu.  Note that submenus should not
normally be attached to pop-up menus as this tends to make the interface more complex and less
intuitive to the user.

Pull-Down Menus

Menu Definition Procedures and Menu Bar Definition Functions

The Menu Manager uses the following to display, and to perform basic operations on, menus and the
menu bar:

• Menu Definition Procedure.  When you define a menu, you must specify the required menu
definition procedure.  The Menu Manager uses that menu definition procedure to draw the
menu items in a menu, determine which item the user chose, insert scrolling indicators as items
in a menu, calculate the menu's dimensions, etc.

• Menu Bar Definition Function.  The Menu Manager uses the menu bar definition function to
draw and clear the menu bar, determine whether the cursor is currently within the menu bar or
any currently displayed menu, calculate the left edges of menu titles, highlight a menu title,
invert the entire menu bar, draw the menu's shadow box, and save/restore the bits behind a
menu.
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Standard Menu Definition Procedure and
Menu Bar Definition Function

The system software provides a standard menu definition procedure and a standard menu bar
definition function, which are stored as code resources in the System file.  The standard menu
definition procedure is the 'MDEF' resource with a resource ID of 0.  The standard menu bar definition
function is the 'MBDF' resource with a resource ID of 0.

When you define your menus and menu bar, you specify the definition routines that the Menu
Manager should use when managing them.  Ordinarily, you will use the standard routines; however,
as with most other elements of the Macintosh user interface, the option is available to write your own
custom definition function/procedure if you need to provide features not available in the standard
routines.1

The Menu Bar and Menus

The Menu Bar

The menu bar extends across the top of the screen.  As defined by the standard menu bar definition
function, the menu bar is white and high enough to display menu titles in the height of the system font
(Chicago 12 point for Roman Scripts) plus a single pixel bottom border.

Generally, the menu bar should always be visible.  If you want to hide the menu bar for some reason,
you should provide a method (for example, a keyboard equivalent for a menu command) to allow the
user to make the menu bar reappear.

The 'MBAR' Resource.  Each application has its own menu bar, which is defined by an 'MBAR'
resource.  This resource lists the order and resource ID of each menu appearing in your menu bar.
Your menu's 'MBAR' resource should be defined such that the Apple menu is the first menu in the menu
bar, with the File and Edit menus being the next two.  The Help and Application menus do not need to
be defined in the 'MBAR' resource, since the Menu Manager automatically adds them to the menu bar
when the application calls GetNewMBar provided that your menu bar includes the Apple menu.

Menus

All Macintosh applications should provide, as a minimum, the standard menus.  The standard menus
are the Apple menu, the File menu and the Edit menu.

Your application can disable any menu, which causes the Menu Manager to dim that menu's title and
all associated menu items.  The menu items can also be disabled individually.  Your application should
specify whether menu items are enabled or disabled when it first defines and creates a menu and can
enable or disable items at any time thereafter.

The 'MENU' Resource.   For each menu, you define the menu title and the individual characteristics
of its menu items in a 'MENU' resource.

The 'mctb' Resource.  Ordinarily, the Menu Manager uses default colours (black text on a white
background) for menus.  However, the default colours of the title, item text, and background can be
changed if you provide a menu colour table ('mctb') resource with the same ID as the associated
'MENU' resource2.

Menu Items

A menu item can contain text or a dividing line (that is, a divider).  A divider is always dimmed.  Each
menu item, other than dividers, can have a number of characteristics as follows:

                                                
1Chapter 18 — Lists and Custom List Definition Functions and Chapter 19 — Custom Control Definition Functions and VBL Tasks include
examples of custom definition functions for other elements of the user interface known as lists and controls.
2If you use ResEdit to create your menu resources, the 'mctb' resource will be created automatically when you specify a coloured title, item
text and/or background within the menu resource editor.
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• An icon, small icon, reduced icon or colour icon to the left of the menu item's text.  (Note that
items with small or reduced icons cannot have submenus.)

• A checkmark or other marking character to the left of the menu item's text, indicating the status
of the menu item or the mode it controls.  (A menu item can have a mark or a submenu, but not
both.)

• The symbol for the Command key ( ) and another 1-byte character to the right of the menu
item's text (referred to as the keyboard equivalent of a command).  (An item that has a keyboard
equivalent cannot have a submenu, a small icon or a reduced icon.)

• A triangular indicator to the right of a menu item's text to indicate that the item has a submenu.
(An item that has a submenu cannot have a keyboard equivalent, a marking character, a small
icon or a reduced icon.)

• A font style (bold, italic, etc.) for the menu item's text.

• The text of the menu item.

• The ellipsis character (…) as the last character in the text of the menu item, indicating that, before
executing the command, the application will display a dialog box requesting more information
from the user.  (The ellipsis character should not be used in menu items which display
informational dialogs or a confirmational alert.3)

• A dimmed appearance when the application disables the item.  (When the menu title is dimmed,
all menu items in that menu are also dimmed.)

A menu can contain any number of menu items; however, only the first 31 can be disabled.

Groups of Menu Items

Where appropriate, menu items should be grouped, with each group separated by a divider.  For
example, a menu can contain commands which perform actions and commands which set attributes.
The action commands which are logically related should be grouped, as should attribute commands
which are interdependent.  The attribute commands which are mutually exclusive, and those which
form accumulating attributes (for example, Bold, Italic and Underline), should also be grouped.

Keyboard Equivalents  for Menu
Commands

The Menu Manager provides support for Command-key equivalents4.  You detect a Command-key
equivalent by examining the modifiers field of the event record for a keyboard event, which allows
you to determine if the Command key was pressed at the same time as the keyboard event.  If so, your
application typically calls MenuKey, which determines if the one-byte character matches any of the
keyboard equivalents defined for your menu items.  (Note that MenuKey does not distinguish between
uppercase and lowercase letters.)

Reserved Keyboard Equivalents.  Apple reserves the following keyboard equivalents, which
should be used in the File and Edit menus of your application:

                                                
3It is interesting to note, however, that Apple itself does not always obey this rule.  For example, choosing About This Macintosh…  (note the
ellipsis) from the Finder's Apple menu displays an informational dialog box only.
4The term keyboard equivalent refers to a keyboard combination, such as -C, or any other combination of the Command key, another key
and one or more modifier keys.  The term Command-key equivalent refers specifically to a keyboard equivalent comprising the Command
key and one other key other than a modifier key.
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Keys Command Menu
-A Select All Edit
-C Copy Edit
-N New File
-O Open… File
-P Print… File
-Q Quit File
-S Save File
-V Paste Edit
-W Close File
-X Cut Edit
-Z Undo Edit

Other common keyboard equivalents are:

Keys Command Menu
-B Bold Style
-F Find File
-G Find Again File
-I Italic Style
-T Plain Text Style
-U Underline Style

Menus Added Automatically By the Menu Manager

The menus added automatically by the Menu Manager (the Help and Application menus) have icons as
titles and are sometimes referred to as the system-managed menus .  The Help menu is displayed only
if space is available.  The application menu is invariably displayed, overlapping the main part of a long
menu if this becomes necessary.

Your application does not need to take any action if the user chooses an item from the Application
menu.  However, if the user chooses an item added by your application to the Help menu, your
application is responsible for taking the appropriate action.

The Apple Menu

The Apple menu should be defined as the first in your application.  Typically, applications provide an
About command as the first menu item, followed by a divider.  The remaining items are, of course,
controlled by the contents of the Apple Menu Items folder in the System folder.

To create your application's Apple menu, firstly define the Apple menu title, the characteristics of your
application's About command and the divider following it in a 'MENU' resource.  Then insert the
contents of the Apple Menu Items folder into your application's Apple menu by calling AppendResMenu,
with 'DRVR' specified as the resource type in the parameter theType.

When the user chooses the About command, your application should display a dialog box or an alert
box containing your application's name, version number, copyright information, any other information
as required, and an OK button.

When the user chooses an item other than the About command, your application should call the
OpenDeskAcc function, which schedules the chosen item for execution and then returns to your
application.  At the next call to WaitNextEvent, your application receives a suspend event and the
chosen item becomes the foreground process.

The File  Menu

The standard File menu contains commands related to the management of documents, plus the Quit
command.  The standard commands (see Fig 1) should be supported by your application.  Any other
commands added to the standard section of the menu should pertain to the management of documents.



Menus 3-5

The actions your application should take when File menu commands are chosen are detailed at Chapter
13 — Printing and Chapter 14 — Files.

FIG 1 - STANDARD FILE MENU

The Edit  Menu

The standard Edit menu (see Fig 2) provides commands which allow the user to edit the contents of
their documents, to copy data between different applications using the Clipboard, and to facilitate data
sharing between documents created by different applications via publish and subscribe.

FIG 2 - STANDARD EDIT MENU

All Macintosh applications should include the standard editing commands (Undo, Cut, Copy, Paste and
Clear) so as to support those operations in dialog boxes and in old-style desk accessories launched in
the application's partition.  (Old-style desk accessories utilise the host application's menus.)

An additional word or phrase should be added to Undo to clarify exactly what action your application
will reverse.  Other commands may be added if they are related to editing or changing the contents of
your application's documents.

The Help Menu

You can add items to the end of the Help menu to give the user access to any online help that your
application provides in addition to help balloons.  Items are added to the Help menu using
HMGetHelpMenuHandle and AppendMenu.  When adding items, include the name of your application in the
command so as to indicate to the user just which application the help relates to.
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Help Balloons

In the Help menu, the effect of selecting Show Balloons and Hide Balloons is global and affects all
applications.  The Help Manager provides balloons for the Apple, Help and Application menu titles,
for items in the Application menu, and for the standard items in the Help menu.  Your application
should provide the content of help balloons for all other menu items and menus in your application.

The Application Menu

When the user chooses an item from the Application menu, the Menu Manager handles the event as
appropriate.  For example, if the user chooses another application, the Menu Manager sends your
application a suspend event.

Font  Menus

If your application has a Font menu, you should list in that menu the names of all currently available
fonts (that is, all those residing in the Fonts folder in the System folder).  Fonts are added to the Font
menu using AppendResMenu or InsertResMenu, which add items to the specified menu in alphabetical
order.

Your application should indicate which font is in use by adding a checkmark to the left of the name in
the Font menu.  If the current selection contains more than one font, a dash should be placed next to the
name of each font the selection contains.  When the user starts entering text at the insertion point, your
application should display text in the current font.

Font Attributes

Separate menus should be used to accommodate lists of font attributes such as styles and sizes.  Since
the system software supports both bitmapped and TrueType fonts, your application should not
provide an upper limit for font sizes.

Pop-Up Menus

Pop-up menus are used to present the user with a list of choices in a dialog box or window.  They are
identified by a downward pointing triangle within the pop-up box (see Fig 3).

Pop-up menus work well when your application needs to present several choices to the user and it is
acceptable to hide these choices until the menu is opened.  (Other methods of displaying choices are
checkboxes and radio buttons.)  Pop-up menus should not be used for multiple choice lists or as a way
to provide more commands.  They should contains attributes rather than actions; accordingly,
Command-key equivalents should not be used in pop-up menus.

FIG 3 - POP-UP MENU (EXAMPLE)

POP-UP TITLE POP-UP BOX

If you do not provide a title for the pop-up menu, the current pop-up menu item serves as the title.

Pop-Up Control Definition Function

The standard pop-up menu is actually implemented as a control, its appearance and behaviour being
determined by a pop-up control definition function.  If the menu is in a dialog box and your
application uses the Dialog Manager, the Dialog Manager uses the pop-up control definition function
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to display the pop-up menu and to handle all user interaction with the menu.  The pop-up control
definition function handles all highlighting and unhighlighting and adds the checkmark to the current
menu item.  When the user releases the mouse button, it changes the text in the pop-up box and stores
the item number of the chosen item as the value of the control5.

Use of Control Manager Routines

The Control Manager function GetControlValue may be used to retrieve the value of the control.

If the pop-up menu is in one of your application's windows, your application needs to determine which
control the cursor was in when the user pressed the mouse button.  Your application can then use
Control Manager routines to display the pop-up menu and to handle user interaction with the control.

Type-In Pop-Up Menus

Type-in pop-up menus (see Fig 4) are used to offer the user a list of choices while, at the same time,
allowing the user to type in an additional choice.

FIG 4 - TYPE-IN POP-UP MENU (EXAMPLE)

The standard pop-up control definition function, however, does not provide specific support for type-
in menus; accordingly, you must create your own control definition function to handle such menus.

Hierarchical Menus

A hierarchical menu is a menu which has a submenu attached to it.  Hierarchical menus should be used
to provide the user with additional choices in the nature of attributes.  They should not be used to
provide additional commands.  There should only ever be one hierarchical level, that is, there should
be only one level of submenus.

Menu Records, Menu IDs, Item Numbers, and Menu Lists

The Menu Record

The Menu Manager maintains information about menus in menu records, a data structure of type
MenuInfo defined in menus.p:

type
MenuInfo = record

menuID: integer;
menuWidth: integer;
menuHeight: integer;
menuProc: Handle;
enableFlags: longint;
menuData: Str255;
end;

                                                
5Controls and their values are explained at Chapter 5 — Controls.
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MenuPtr = ^MenuInfo;
MenuHandle = ^MenuPtr;
MenuRef = MenuHandle;

You typically specify most of this information in a 'MENU' resource.  When you create a menu, the
Menu Manager creates a menu record for the menu and returns a handle to that record.  The Menu
Manager automatically updates the menu record when you make any changes to the menu.

Menu IDs

To refer to a menu, you usually use either the menu's ID or the handle to the menu's menu record.
Accordingly, you must assign a menu ID to each menu in your application as follows:

• Pull-down and pop-up menus must use a menu ID greater than 0.

• Submenus of an application must use a menu ID of from 1 to 235.

Item Numbers

To refer to a menu item, you use the item's item number.  Item numbers in a menu start at 1.

The Menu List

The  menu list  contains handles to the menu records of one or more menus (although a menu list can,
in fact, be empty).  The end of a menu list contains handles to the menu records of submenus and pop-
up menus, if any, the phrase "submenu portion of the menu list" referring to this portion of the list.

When your application initialises the Menu Manager, the Menu Manager creates the menu list.  The
menu list is initially empty but changes as your application adds menus to it or removes menus from it.

Creating Your Application's Menus

Creating Resources

Creating 'MENU'  Resources for Menus

A  'MENU' resource defines the menu title and the characteristics of menu items in a menu.  The
following is a typical 'MENU' resource in Rez format, in this case a resource for the Apple menu:

#define mApple 128
...
resource 'MENU' (mApple, preload) /* Resource ID, preload resource. */
{

mApple, /* Menu ID. */
textMenuProc, /* Uses standard menu definition procedure. */
0b1111111111111111111111111111101, /* Enable About, disable divider, enable rest. */
enabled, /* Enable menu title. */
apple, /* Menu title. */
{

"About This Application…", /* FIRST MENU ITEM text. */
noicon, /*   Icon number (if any). */
nokey, /*   Keyboard equivalent or submenu or icon. */
nomark, /*   Marking character or submenu ID. */
plain; /*   Style of menu item text. */

"-", /* SECOND MENU ITEM text. */
noicon,nokey,nomark,plain

}
};

Resource ID and Menu ID.  The resource ID for this menu is specified as 128.  Any number equal to
or greater than 128 may be used as the resource ID for a menu.  By convention, 128 is used as the
resource ID of the Apple menu and sequential numbers are used for the remaining menus.  Also by
convention, the menu ID is usually set to the same number as the resource ID, though this is not strictly
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necessary.  (As previously stated, any number greater than 0 may be used as the menu ID of a pull-
down or pop-up menu.)

Menu Definition Procedure.  The listing specifies that this menu uses the standard menu definition
procedure.  The constant textMenuProc represents the standard 'MDEF' resource ID.

Item Enable/Disable.  The 32-bit number, which is expressed as a 31-bit field followed by a Boolean
field, indicates whether the corresponding menu item is to be enabled or disabled, with bit 0 indicating
whether the menu is enabled or disabled.

Title.  The title of the menu is specified by the constant apple, causing the Menu Manager to use a
small Apple icon as the title of the menu.

Item Text and Characteristics.  The listing then defines the text and other characteristics of each
menu item.  By specifying various combinations of values in the icon field and keyboard equivalent
field, you can define an icon (normal, small, reduced or colour), a keyboard equivalent, or a submenu.
(Some of these characteristics are, as previously explained, mutually exclusive.)

Creating 'MENU'  Resources for Submenus

When a submenu is attached to a menu item in a pull-down menu, the name of the menu item is the
title of the attached submenu.  In Rez, you can specify that a particular menu item has a submenu by
identifying this characteristic (using the hierarchicalMenu constant) when you define the menu item in
its 'MENU' resource.  You identify the menu ID of the submenu in place of the marking character.  In the
following example of a Rez input for a 'MENU' resource, Label style is the menu item text and
mSubMenu is the menu ID of the submenu:

#define mOutline 135
#define mSubMenu 181
...
resource 'MENU' (mOutline, preload)
{

mOutline,
textMenuProc,
0b0000000000000000000000000010000,
enabled,
"Outline", /* Menu title */
{

"Expand", noicon, "E", nomark, plain;
"Collapse", noicon, nokey, nomark, plain;
"Label style ", noicon, hierarchicalMenu, mSubMenu , plain

}
};

resource 'MENU' (mSubMenu, preload)
{

mSubMenu ,
textMenuProc,
0b0000000000000000000000000000011,

enabled,
"Label Style ", /* Menu title (ignored because defined by parent item text.) */
{

"Alphabetic", noicon, nokey, nomark, plain;
"Bullet", noicon, nokey, nomark, plain

}
};

The menu items of a submenu are defined in the same way as for a pull-down menu

Creating an 'MBAR'  Resource

Your application's menu bar is defined in an 'MBAR' resource.  An example is as follows:

#define rMenuBar 128
#define mApple 128
#define mFile 129
#define mEdit 130
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...
resource 'MBAR' (rMenuBar, preload) /* Resource ID, preload */
{

{ mApple, mFile, mEdit }; /* Resource IDs of menus in this menu bar */
};

Help Balloons - 'hmmu'  Resources

You should also define Help balloons for each of your application's menu items and each menu title.
Help balloons are defined in 'hmmu' resources.

Creating the Menu Bar and Pull-Down Menus

Your application should call GetNewMBar to create a menu list as defined in an 'MBAR' resource.
GetNewMBar returns a handle to the created menu list.  For each menu defined by the resource,
GetNewMBar creates a menu record, creates each menu according to the menu definition in its
corresponding 'MENU' resource, and inserts each menu into the menu list.

SetMenuBar should then be used to set the current menu list as the menu list created by your
application.  A call to DrawMenuBar completes the process by drawing the menu bar, displaying all the
menu titles in the current menu list.

Adding Menus to the Menu List

A menu may be added to the current menu list using one of the following procedures:

• Read the relevant 'MENU' resource in with GetMenu, add it to the current menu list with
InsertMenu, and update the menu bar with DrawMenuBar.

• Use NewMenu to create a new empty menu, use AppendMenu, InsertMenuItem, InsertResMenu, or
AppendResMenu to fill the menu with menu items, add the menu to the current menu list using
InsertMenu, and update the menu bar using DrawMenuBar.

Note that GetMenuHandle may be used to obtain a handle to the menu record of any menu in the current
menu list.

Creating a Hierarchical Menu

GetNewMBar does not read in the resource descriptions of submenus but simply records the menu ID of
any submenu in the menu record.  Submenu descriptions are read in with GetMenu and the submenu is
inserted in the current menu list using InsertMenu, with the constant hierMenu passed as the second
parameter to that call.6

Creating a Pop-Up Menu

As previously stated, pop-up menus are actually implemented as controls.  To create a pop-up menu,
define the pop-up menu and its menu items in the same way as for other menus (that is, using a 'MENU'
resource), create a control which uses the standard pop-up control definition function (that is, specify
the popupMenuProc constant in procID field of the resource description of the control), and associate the
control with a window or dialog box7.

If you specify popupMenuProc in the procID field of the resource description of a control, when your
application creates the control (with a call to GetNewControl), the Control Manager creates the pop-up
control, which includes the pop-up title and the pop-up box with a one-pixel drop shadow.

                                                
6As the user traverses menu items, if an item has a submenu, the MenuSelect function looks in the submenu portion of the menu list for the
submenu.  It then searches for a menu with a defined menu ID that matches the menu ID specified by the hierarchical menu item.  If it finds a
match, it attaches the submenu to the menu item.
7If you add the constant useWFont to the constant popupMenuProc, the pop-up title and menu item text will be drawn in the current graphics
port's font rather than the system font.



Menus 3-11

Pop-up Menus in Dialog Boxes

Dialog Manager or Control Manager routines, not Menu Manager routines, are used to display and
manage pop-up menus.  For example, if you define a modal dialog box that contains a pop-up control
and use the Dialog Manager to display and help handle events in the dialog box, the Dialog Manager
automatically uses the pop-up control definition function to draw the control and handle all user
interaction.  The Control Manager function GetControlValue will get the value of the control, which
will equate to the number of the item selected by the user.

Pop-up Menus in Windows

If your application defines a control in one of your application's windows, you can use TrackControl
and other Control Manager routines to handle the pop-up menu.

Changing the Appearance of Items in a Menu

Menu Manager routines may be used to change the appearance of items in a menu, for example, the
font style, text or other characteristics.  Most of the routines which get or set menu characteristics
require three parameters:

• A handle to the menu record of the menu containing the desired item.

• The number of the menu item.

• A variable which either specifies the data to set or identifies where to return information about
that item.

Enabling and Disabling Menu Items

Specific menu items or entire menus are disabled and enabled using DisableMenu and EnableMenu,
which both take a handle to the menu record that identifies the desired menu and either the item
number of the menu to be enabled/disabled or a value of 0 to indicate that the entire menu is to be
enabled/disabled.

When an entire menu is disabled or enabled, DrawMenuBar should be called to update the appearance of
the menu bar.  If you do not need to update the menu bar immediately, you can use InvalMenuBar
instead of DrawMenuBar, causing the Event Manager to redraw the menu bar the next time it scans for
update events.  This will reduce the menu bar flicker which will occur if DrawMenuBar is called more
than once in rapid succession.

If you disable an entire menu, the Menu Manager dims that menu's title at the next call to DrawMenuBar
and dims all menu items when it displays the menu.  If you enable an entire menu, the Menu Manager
enables only the menu title and any items that you did not previously disable individually.

Changing the Text and Font Style of Menu Items

GetMenuItemText and SetMenuItemText are used to get and set the text of a menu item.  GetItemStyle
and SetItemStyle are used to get and set the font style of a menu item.

Changing the Mark and Icons of Menu Items

GetItemMark and SetItemMark are used to get and set the marking character of a menu item.
GetItemIcon and SetItemIcon are used to get and set the icon of a menu.
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Adding Items to a Menu

Adding Items Other Than the Names of Resources

AppendMenu or InsertMenuItem are used to add items other than the names of resources (such as font
resources) to a previously created menu.  These functions allow you to specify the same characteristics
for menu items as are available when defining a 'MENU'  resource.  They require:

• A handle to the menu record of the menu involved.

• A string describing the items to add.

The string consists of the text of the menu item and any required characteristics.  You can specify a
hyphen as the menu item text to create a divider line.  You can also use various metacharacters in the
text string to separate menu items and to specify the required characteristics.  The following
metacharacters may be used:

MetaCharacter Description
; or Return Separates menu items.

^ When followed by an icon number, defines the icon for the item.

! When followed by a character, defines the mark for the item.
If the keyboard equivalent field contains $1B, this value is interpreted as the menu ID of a
submenu of this menu item.

< When followed by one or more of the characters B, I, U, O, and S, defines the character style
of the item to, respectively, bold, italic, underline, outline or shadow.

/ When followed by a character, defines the keyboard equivalent for the item.
When followed by $1B, specifies that this menu item has a submenu.
(To specify that the menu item has a script code, small icon, or reduced icon, use SetItemCmd
to set the keyboard equivalent field to, respectively, $1C,$1D or $1E.)

( Defines the menu item as disabled.

As an example of the use of metacharacters, the following is a string list ('STR#') resource, in Rez input
format, which stores the text of some menu items:

resource 'STR#' (300, "Text for appended menu items") {
{

/* [1] */
"Pick a Colour…";
/* [2] */
"(^2!=Everything<B/E";

}
};

The second string in this resource uses metacharacters to specify that the menu item is to be disabled,
that it has an icon with a resource ID 258 (2+256)8, that it has the "=" character as a marking character,
that the text style is bold, and that the item has a keyboard equivalent of Command-E.

Examples

The following code uses AppendMenu to append a menu item with no specific characteristics other than
its text to the menu identified by the menu handle.  The text for the menu item is "Pick a Colour…" as
stored in the preceding 'STR#' resource.

var
   myMenu: MenuHandle;
   itemString: string;

...
myMenu := GetMenuHandle(mLibrary);
GetIndString(itemString,300,1);
AppendMenu(myMenu,itemString);

                                                
8The Menu Manager adds 256 to the number you specify, and uses the result as the icon's resource ID.
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To insert an item after a given menu item, use InsertMenuItem.  The following code inserts the menu
item "Everything" after the menu item with the item number specified in the iRed constant:

var
   myMenu: MenuHandle;
   itemString: string;

...
myMenu := GetMenuHandle(mColours);
GetIndString(itemString,300,2);
InsertMenuItem(myMenu,itemString,iRed);

The following code appends multiple items to the Edit menu using AppendMenu:

var
   myMenu: MenuHandle;

...
myMenu := GetMenuHandle(mEdit);
AppendMenu(myMenu,'Undo/Z;-;Cut/X;Copy/C;Paste/V');

InsertMenuItem differs from AppendMenu in the way it handles the given text string when that string
contains multiple items, inserting them in reverse order.  This code is equivalent to the last line of the
preceding code:

InsertMenuItem(myMenu,'Paste/V;Copy/C;Cut/X-;-;Undo/Z',0);

The following code adds a divider to the Edit menu:

myMenu := GetMenuHandle(mFile);
AppendMenu(myMenu,'(-');

Adding Items Comprising Resource Names to a Menu

AppendResMenu or InsertResMenu may be used to add items that consist of resource names to a menu.

For example, you can use AppendResMenu to add the names of all font resources in the Fonts folder as
menu items in your application's Font menu.  Similarly, AppendResMenu can be used to add all of the
items from the Apple Menu Items folder to your application's Apple menu (with 'DRVR' specified as
the resource type in the call).  These are common instances of when you will need to add items not
already defined in a 'MENU' resource.

Items are added to your application's Help menu using AppendMenu or InsertMenuItem.

Handling Menu Choices

Determining the Menu ID and Menu Item — MenuSelect  and MenuKey

When the user presses the mouse button while the cursor is in the menu bar, your application should
first adjust its menus (that is, enable or disable menu items and add or remove marks as required) and
then call MenuSelect.  MenuSelect tracks the mouse, displays menus, highlights menu titles, displays
and highlights enabled menu items, handles all user activity until the user releases the mouse button,
and returns a long integer as its function result.  The long integer contains the menu ID in the high
word and the item number in the low word.

If some of your menu items have keyboard equivalents, your application should detect such key-down
events.  If an examination of the modifiers field of the event record reveals that the Command key was
down, your application should first adjust its menus and then call MenuKey.  MenuKey scans the current
menu list for a menu item that has a matching keyboard equivalent.  Like MenuSelect, MenuKey returns
a long integer indicating which menu item was chosen.
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If the user did not actually choose a menu command with the mouse, or if the user pressed a keyboard
combination which did not map to a keyboard equivalent,  MenuSelect and MenuKey return 0 in the high
word, the value in the low word being undefined.

The long word returned by MenuSelect and MenuKey should be passed as a parameter to an application-
defined function which switches according to the menu ID in the high word and passes the low word
to other application-defined functions which respond appropriately to that menu command.

Unhighlighting the Menu Title

Recall that one of the actions of MenuSelect and MenuKey is to highlight the menu title.   Ordinarily, your
application should not unhighlight the menu title (using HiLiteMenu) until it performs the action
associated with the menu command chosen by the user.  However, if, in response to a menu command,
your application displays a modal dialog box containing an editable text item, you should unhighlight
the menu title immediately so that the user can access the Edit menu.

Adjusting Menus

Menu adjustment should be on the basis of the type of window that is currently the frontmost window,
for example, a text window, a desk accessory, a modal dialog box or a modeless dialog box.
Accordingly, the application-defined menu adjustment function should first determine which window
is the front window.  The following are examples of menu adjustment functions:

procedure doAdjustMenus;

var
myWindowPtr: WindowPtr;
windowType: integer;

begin
myWindowPtr:= FrontWindow;
windowType := doGetWindowType(myWindowPtr);

case windowType of

kMyDocWindow:
begin
doAdjustFileMenuForDocWindow;
doAdjustEditMenuForDocWindow;
{Adjust others.}
end;

kMyDialogWindow:
begin
doAdjustMenusForDialogs;
end;

kNil:
begin
doAdjustMenusNoWindows;
end;

end;
{of case statement}

DrawMenuBar;
end;

{of procedure doAdjustMenus}

procedure doAdjustFileMenuForDocWindow;

var
menuHdl: MenuHandle;

begin
menuHdl := GetMenuHandle(mFile);

EnableItem (menuHdl,iNew);
EnableItem (menuHdl,iOpen);
EnableItem(menuHdl,iClose);
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DisableItem(menuHdl,iSave);
DisableItem(menuHdl,iSaveAs);
DisableItem(menuHdl,iPageSetup);
DisableItem(menuHdl,iPrint);
EnableItem (menuHdl,iQuit);

end;
{of procedure doAdjustFileMenuForDocWindow}

Handling Apple Menu Choices

When the user chooses an item in the Apple menu, MenuSelect returns the menu ID of your
application's Apple menu in the high word and the item number in the low word.

If your application provides an About command as the first menu item in the Apple menu, and the user
chooses this item, you should display the About box.  Otherwise, your application should use the
GetMenuItemText function to get the menu item text and then call the OpenDeskAcc function, passing the
text of the chosen menu item as a parameter.

The OpenDeskAcc function prepares to open the desktop object chosen by the user.  For example, if the
user chose a document created by the SimpleText application, OpenDeskAcc schedules SimpleText for
execution (or prepares to open it if it was not already open) and returns to your application.  On your
application's next call to WaitNextEvent, your application receives a suspend event and the Process
Manager makes SimpleText the foreground process, instructing it to open the chosen document.

Handling Help Menu Choices

Both the MenuSelect and MenuKey functions return the kHMHelpMenuID constant (-16490) in the high
word if the user chooses an appended item from the Help menu.  The item number of the appended
item is returned in the low word.  When the kHMHelpMenuID constant is detected, an application-defined
function should be called to respond to the user's choice of a Help menu command.  That function must
accommodate the fact that Apple reserves the right to change the number of standard items in the Help
menu.

Handling a Size Menu

Preamble

Font sizes in Size menus should be outlined to indicate which sizes are directly provided by the current
font.  For bitmapped fonts, you should outline only those sizes that exist in the Fonts folder.  For
TrueType fonts, all sizes supported by that font should be outlined.  The current font size should be
indicated with a checkmark.  If the current selection contains more than one font size, a dash should be
placed next to each font size in the selection.

Size menus should, in addition to displaying available font sizes, provide an Other command to enable
the user to specify a size not currently listed in the menu.  When the user chooses the Other command,
the current font size should be displayed in a dialog box which allows the user to enter the desired font
size.  If the user chooses a size not already in the menu, a check mark should be added to the Other
menu item and the chosen size should be added in parenthesis to the text of the Other command.

Handling the Menu Choice

The following is an example application-defined function which handles a user's choice of an item in
the Size menu:

procedure doHandleSizeCommand(menuItem: integer);

var
numItems:  integer;
addItem:  boolean;
sizeChosen:  longint;
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begin
numItems := CountMItems(GetMenuHandle(mSize));
if (menuItem = numItems) {If user chose Other, display dialog box.}

then begin
doDisplayOtherBox(sizeChosen);

 {If the user-specified size is not in the menu, add a checkmark to the
Other command and add the new font size to the text of the Other command.}

end

else begin  {User chose a size.}
doRemoveMarksFromSizeMenu; {Remove marks from item/s showing previous size.}
CheckItem(GetMenuHandle(mSize), menuItem, true);  {Add mark to chosen item}
sizeChosen := doItemToSize(menuItem); {Convert item number to font size.}
end;

doResizeSelection(sizeChosen); {Update document state or user selection.}
end;

Accessing Menus From Alert and Dialog Boxes

When alert boxes and dialog boxes are displayed, the Dialog Manager and the Menu Manager interact
to provide varying degrees of access to menus in your menu bar.  In some circumstances, you can rely
on the system software to disable the appropriate menus and menu items.  In other circumstances, you
application must contribute to, or control, the matter of menu access.

The subject of menu access when alert boxes, modal dialog boxes, moveable modal dialog boxes, and
modeless dialog boxes are displayed is somewhat involved, and is addressed in detail at Chapter 6 —
Dialogs and Alerts.

Main Menu Manager Constants, Data Types and Routines

Constants

For markChar  Parameter of SetItemMark Calls

noMark = 0
commandMark = 17
checkMark = 18
diamondMark = 19
appleMark = 20

For beforeID  Parameter of InsertMenu  to Insert Submenu or Pop-up Menu Into the Submenu
Portion of the Menu List

hierMenu = -1

Data Types

Menu Record

type
MenuInfo = record

menuID: integer;
menuWidth: integer;
menuHeight: integer;
menuProc: Handle;
enableFlags: longint;
menuData: Str255;

end;

MenuPtr = ^MenuInfo;
MenuHandle = ^MenuPtr;
MenuRef = MenuHandle;
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Routines

Note:  Some Menu Manager routines can be accessed using more than one spelling of the routine's name,
depending on the interface files supported by your development environment.  The following reflects the newest
spellings, as specified in version 2.1 of the Universal Interfaces.

Initializing the Menu Manager

procedure InitMenus;

Creating Menus

function NewMenu(menuID: integer; menuTitle: ConstStr255Param): MenuRef;
function GetMenu(resourceID: integer): MenuRef;

Adding Menus to and Removing Menus From the Current Menu List

procedure InsertMenu(theMenu: MenuRef; beforeID: integer);
procedure DeleteMenu(menuID: integer);
procedure ClearMenuBar;

Getting a MenuBar Description From an 'MBAR'  resource

function GetNewMBar(menuBarID: integer): Handle;

Getting and Setting the Menu Bar

function GetMenuBar: Handle;
procedure SetMenuBar(menuList: Handle);
function GetMBarHeight: integer;

Drawing the Menu Bar

procedure DrawMenuBar;
procedure InvalMenuBar;

Responding to User Choice of a Menu Command

function MenuKey(ch: char): longint;
function MenuSelect(startPt: Point): longint;
function MenuChoice(void);
procedure HiliteMenu(menuID: integer);
function PopUpMenuSelect(menu: MenuRef; top: integer; left: integer;

popUpItem: integer): longint;

Getting a Handle to a Menu Record

function GetMenuHandle(menuID: integer): MenuRef;
function HMGetHelpMenuHandle(var mh: MenuRef): OSErr;

Adding and Deleting Menu Items

procedure AppendMenu(menu: MenuRef; data: ConstStr255Param);
procedure InsertMenuItem(theMenu: MenuRef; itemString: ConstStr255Param;

afterItem: integer);
procedure DeleteMenuItem(theMenu: MenuRef; item: integer);
procedure AppendResMenu(theMenu: MenuRef; theType: ResType);
procedure InsertResMenu(theMenu: MenuRef; theType: ResType; afterItem: integer);

Getting and Setting the Appearance of Menus

procedure EnableItem(theMenu: MenuRef; item: integer);
procedure DisableItem(theMenu: MenuRef; item: integer);
procedure GetMenuItemText(theMenu: MenuRef; item: integer; var itemString: Str255);
procedure SetMenuItemText(theMenu: MenuRef; item: integer; itemString: ConstStr255Param);
procedure GetItemStyle(theMenu: MenuRef; item: integer; var chStyle: Style);
procedure SetItemStyle(theMenu: MenuRef; item: integer; chStyle: Style);
procedure GetItemMark(theMenu: MenuRef; item: integer; var markChar: char);
procedure SetItemMark(theMenu: MenuRef; item: integer; markChar: char);
procedure CheckItem(theMenu: MenuRef; item: integer; checked: boolean);
procedure GetItemIcon(theMenu: MenuRef; item: integer; var iconIndex: Byte);
procedure SetItemIcon(theMenu: MenuRef; item: integer; iconIndex: integer);
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procedure GetItemCmd(theMenu: MenuRef; item: integer; var cmdChar: char);
procedure SetItemCmd(theMenu: MenuRef; item: integer; cmdChar: char);

Disposing of Menus

procedure DisposeMenu(theMenu: MenuRef);

Counting Items in a Menu

function CountMItems(theMenu: MenuRef): integer;

Highlighting the Menu Bar

procedure FlashMenuBar(menuID: integer);
procedure SetMenuFlash(count: integer);

Recalculating Menu Dimensions

procedure CalcMenuSize(theMenu: MenuRef);

Demonstration Program
{ ######################################################################################1

// MenusPascal.p2

// #####################################################################################3

//4

// This program:5

//6

// • Opens a window.7

//8

// • Creates these pull-down menus: Apple, File, Edit, Font, Size and Special.9

//10

// The Apple menu includes an 'About…' menu item for the program.11

//12

// The second menu item in the Special menu contains a submenu.13

//14

// A 'Help' menu item for the program is appended to the Help menu.15

//16

// • Creates a pop-up menu in the window.17

//18

// • Displays text in the window indicating the menu selection made by the user.19

//20

// The implementation of the Size menu is nominal only.  The current size is indicated21

// with a checkmark; however, the number of sizes shown is not font-dependent and there22

// is no 'Other' item.23

//24

// Because the primary purpose of the program is to demonstrate menu creation and25

// handling, no code is included to update and activate/deactivate the window or to26

// respond to events which are not relevant to the demonstration.27

//28

// The program is terminated by selecting Quit from the File menu, by pressing the29

// keyboard equivalent for that item (Command-Q), or by clicking in the window's go-away30

// box.31

//32

// The program utilises the following resources:33

//34

// • A 'WIND' resource (purgeable) (initially not visible).35

//36

// • An 'MBAR' resource (preload, non-purgeable).37

//38

// • 'MENU' resources for the drop-down, hierarchical and pop-up menus (all preload,39

// all non-purgeable).40

//41

// • A 'CNTL' resource for the pop-up menu (purgeable).42

//43

// ##################################################################################### }44

45

program MenusPascal(input, output);46

47

{ ………………………………………………………………………………………………………………… include the following Universal Interfaces }48

49

uses50

51
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Windows, Fonts, Menus, Controls, TextEdit, Dialogs, Quickdraw, Devices, Events, Types,52

Processes, Memory, Balloons, ToolUtils, QuickdrawText, OSUtils, Segload;53

54

{ ………………………………………………………………………………………………………………………………………………… define the following constants }55

56

const57

58

mApple = 128;59

iAbout = 1;60

61

mFile = 129;62

iQuit = 11;63

64

mEdit = 130;65

iUndo = 1;66

iCut = 3;67

iCopy = 4;68

iPaste = 5;69

iClear = 6;70

71

mFont = 131;72

73

mStyle = 132;74

iPlain = 1;75

iBold = 3;76

iItalic = 4;77

iUnderline = 5;78

iOutline = 6;79

iShadow = 7;80

81

mSize = 133;82

iTen = 1;83

iTwelve = 2;84

iEighteen = 3;85

iTwentyFour = 4;86

87

mSpecial = 134;88

iFirstItem = 1;89

hmSecondItem = 100;90

siFirstSub = 1;91

siSecondSub = 2;92

93

pControlResID = 128;94

pSydney = 1;95

pNewYork = 2;96

pLondon = 3;97

pRome = 4;98

99

rWindowResource = 128;100

101

{ ……………………………………………………………………………………………………………………………………………………………………………………… global variables }102

103

var104

105

gDone : Boolean;106

gCurrentFont : integer;107

gCurrentStyle : Style;108

gCurrentSize : integer;109

eventRec : EventRecord;110

myWindowPtr : WindowPtr;111

112

{ ######################################################################## ProcedureName }113

114

procedure DoInitManagers;115

116

begin117

MaxApplZone;118

MoreMasters;119

120

InitGraf(@qd.thePort);121

InitFonts;122

InitWindows;123

InitMenus;124

TEInit;125

InitDialogs(nil);126

127
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InitCursor;128

FlushEvents(everyEvent, 0);129

end;130

{of procedure DoInitManagers}131

132

{ ###################################################################### DrawItemString }133

134

procedure DrawItemString(eventString : string);135

136

var137

tempRegion : RgnHandle;138

myWindowPtr : WindowPtr;139

scrollBox : Rect;140

141

begin142

myWindowPtr := FrontWindow;143

tempRegion := NewRgn;144

145

scrollBox := myWindowPtr^.portRect;146

scrollBox.top := scrollBox.top + 50;147

148

ScrollRect(scrollBox, 0, -24, tempRegion);149

DisposeRgn(tempRegion);150

151

MoveTo(8, 286);152

DrawString(eventString);153

end;154

{of procedure DrawItemString}155

156

{ ############################################################ DoCheckForControlAndValue }157

158

function DoCheckForControlAndValue(eventRec : EventRecord;159

myWindowPtr: WindowPtr) : integer;160

161

var162

controlHdl : ControlHandle;163

startControlValue, finishControlValue, ignored : integer;164

165

begin166

SetPort(myWindowPtr);167

GlobalToLocal(eventRec.where);168

169

if (FindControl(eventRec.where, myWindowPtr, controlHdl) <> 0) then170

begin171

startControlValue := GetControlValue(controlHdl);172

ignored := TrackControl(controlHdl, eventRec.where, ControlActionUPP(-1));173

finishControlValue := GetControlValue(controlHdl);174

end;175

176

if (finishControlValue <> startControlValue)177

then DoCheckForControlAndValue := finishControlValue178

else DoCheckForControlAndValue := 0;179

180

end;181

{of function DoCheckForControlAndValue}182

183

{ ######################################################################## DoAdjustMenus }184

185

procedure DoAdjustMenus;186

187

begin188

189

{Adjust menus here}190

191

end;192

{of procedure DoAdjustMenus}193

194

{ #################################################################### DoPopupMenuChoice }195

196

procedure DoPopupMenuChoice(popupItem : integer);197

198

begin199

case (popupItem) of200

201

pSydney:202

begin203
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DrawItemString('Sydney');204

end;205

206

pNewYork:207

begin208

DrawItemString('New York');209

end;210

211

pLondon:212

begin213

DrawItemString('London');214

end;215

216

pRome:217

begin218

DrawItemString('Rome');219

end;220

end;221

{of case statement}222

223

end;224

{of procedure DoPopupMenuChoice}225

226

{ ########################################################################## DoAppleMenu }227

228

procedure DoAppleMenu(menuItem : integer);229

230

var231

itemName : string;232

daDriverRefNum : integer;233

234

begin235

if (menuItem = iAbout)236

then DrawItemString('About Menus…')237

238

else begin239

GetMenuItemText(GetMenuHandle(mApple), menuItem, itemName);240

daDriverRefNum := OpenDeskAcc(itemName);241

end;242

243

end;244

{of procedure DoAppleMenu}245

246

{ ########################################################################### DoFileMenu }247

248

procedure DoFileMenu(menuItem : integer);249

250

begin251

if (menuItem  = iQuit) then252

gDone := true;253

end;254

{of procedure DoFileMenu}255

256

{ ########################################################################### DoEditMenu }257

258

procedure DoEditMenu(menuItem : integer);259

260

begin261

case (menuItem) of262

263

iUndo:264

begin265

DrawItemString('Undo');266

end;267

268

iCut:269

begin270

DrawItemString('Cut');271

end;272

273

iCopy:274

begin275

DrawItemString('Copy');276

end;277

278

iPaste:279
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begin280

DrawItemString('Paste');281

end;282

283

iClear:284

begin285

DrawItemString('Clear');286

end;287

288

end;289

{of case statement}290

291

end;292

{of procedure DoEditMenu}293

294

{ ########################################################################### DoFontMenu }295

296

procedure DoFontMenu(menuItem : integer);297

298

var299

fontMenuHdl : MenuHandle;300

fontName : string;301

fontNumber : integer;302

303

begin304

fontMenuHdl := GetMenuHandle(mFont);305

306

CheckItem(fontMenuHdl, gCurrentFont, false);307

CheckItem(fontMenuHdl, menuItem, true);308

309

gCurrentFont := menuItem;310

311

GetMenuItemText(fontMenuHdl, menuItem, fontName);312

GetFNum(fontName, fontNumber);313

TextFont(fontNumber);314

315

DrawItemString(fontName);316

317

end;318

{of procedure DoFontMenu}319

320

{ ########################################################################## DoStyleMenu }321

322

procedure DoStyleMenu(menuItem : integer);323

324

var325

styleMenuHdl : MenuHandle;326

327

begin328

case (menuItem) of329

330

iPlain:331

begin332

gCurrentStyle := [];333

end;334

335

iBold:336

begin337

if (bold in gCurrentStyle)338

then gCurrentStyle := gCurrentStyle - [bold]339

else gCurrentStyle := gCurrentStyle + [bold];340

end;341

342

iItalic:343

begin344

if (italic in gCurrentStyle)345

then gCurrentStyle := gCurrentStyle - [italic]346

else gCurrentStyle := gCurrentStyle + [italic];347

end;348

349

iUnderline:350

begin351

if (underline in gCurrentStyle)352

then gCurrentStyle := gCurrentStyle - [underline]353

else gCurrentStyle := gCurrentStyle + [underline];354

end;355
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356

iOutline:357

begin358

if (outline in gCurrentStyle)359

then gCurrentStyle := gCurrentStyle - [outline]360

else gCurrentStyle := gCurrentStyle + [outline];361

end;362

363

iShadow:364

begin365

if (shadow in gCurrentStyle)366

then gCurrentStyle := gCurrentStyle - [shadow]367

else gCurrentStyle := gCurrentStyle + [shadow];368

end;369

end;370

{of case statement}371

372

styleMenuHdl := GetMenuHandle(mStyle);373

374

CheckItem(styleMenuHdl, iPlain, (gCurrentStyle = []));375

CheckItem(styleMenuHdl, iBold, (bold in gCurrentStyle));376

CheckItem(styleMenuHdl, iItalic, (italic in gCurrentStyle));377

CheckItem(styleMenuHdl, iUnderline, (underline in gCurrentStyle));378

CheckItem(styleMenuHdl, iOutline, (outline in gCurrentStyle));379

CheckItem(styleMenuHdl, iShadow, (shadow in gCurrentStyle));380

381

TextFace(gCurrentStyle);382

383

DrawItemString('Style change');384

385

end;386

{of procedure DoStyleMenu}387

388

{ ########################################################################### DoSizeMenu }389

390

procedure DoSizeMenu(menuItem : integer);391

392

var393

sizeMenuHdl : MenuHandle;394

395

begin396

case (menuItem) of397

398

iTen:399

begin400

TextSize(10);401

end;402

403

iTwelve:404

begin405

TextSize(12);406

end;407

408

iEighteen:409

begin410

TextSize(18);411

end;412

413

iTwentyFour:414

begin415

TextSize(24);416

end;417

end;418

{of case statement}419

420

sizeMenuHdl := GetMenuHandle(mSize);421

422

CheckItem(sizeMenuHdl, gCurrentSize, false);423

CheckItem(sizeMenuHdl, menuItem, true);424

425

gCurrentSize := menuItem;426

427

DrawItemString('Size change');428

429

end;430

{of procedure DoSizeMenu}431
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432

{ ######################################################################## DoSpecialMenu }433

434

procedure DoSpecialMenu(menuItem : integer);435

436

begin437

if(menuItem = iFirstItem) then438

DrawItemString('First Item');439

end;440

{of procedure DoSpecial}441

442

{ ########################################################################### DoSubMenus }443

444

procedure DoSubMenus(menuItem : integer);445

446

begin447

case (menuItem) of448

449

siFirstSub:450

begin451

DrawItemString('Subitem 1');452

end;453

454

siSecondSub:455

begin456

DrawItemString('Subitem 2');457

end;458

459

end;460

{of case statement}461

end;462

{of procedure DoSubMenus}463

464

{ ########################################################################### DoHelpMenu }465

466

procedure DoHelpMenu(menuItem : integer);467

468

var469

helpMenuHdl : MenuHandle;470

origHelpItems, numItems : integer;471

theErr : OSErr;472

473

begin474

theErr := HMGetHelpMenuHandle(helpMenuHdl);475

476

if (theErr <> noErr) then477

begin478

SysBeep(10);479

ExitToShell;480

end;481

482

numItems := CountMItems(helpMenuHdl);483

origHelpItems := numItems - 1;484

485

if (menuItem > origHelpItems) then486

DrawItemString('Menus Help');487

end;488

{of procedure DoHelpMenu}489

490

{ ######################################################################### DoMenuChoice }491

492

procedure DoMenuChoice(menuChoice : longint);493

494

var495

menuID, menuItem : longint;496

497

begin498

menuID := HiWord(menuChoice);499

menuItem := LoWord(menuChoice);500

501

if (menuID = 0) then502

exit(DoMenuChoice);503

504

case (menuID) of505

506

mApple:507
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begin508

DoAppleMenu(menuItem);509

end;510

511

mFile:512

begin513

DoFileMenu(menuItem);514

end;515

516

mEdit:517

begin518

DoEditMenu(menuItem);519

end;520

521

mFont:522

begin523

DoFontMenu(menuItem);524

end;525

526

mStyle:527

begin528

DoStyleMenu(menuItem);529

end;530

531

mSize:532

begin533

DoSizeMenu(menuItem);534

end;535

536

mSpecial:537

begin538

DoSpecialMenu(menuItem);539

end;540

541

hmSecondItem:542

begin543

DoSubMenus(menuItem);544

end;545

546

kHMHelpMenuID:547

begin548

DoHelpMenu(menuItem);549

end;550

551

end;552

{of case statement}553

554

HiliteMenu(0);555

end;556

{of procedure DoMenuChoice}557

558

{ ########################################################################## DoMouseDown }559

560

procedure DoMouseDown(eventRec : EventRecord);561

562

var563

myWindowPtr : WindowPtr;564

partCode, popupItem : integer;565

menuChoice : longint;566

567

begin568

partCode := FindWindow(eventRec.where, myWindowPtr);569

570

case (partCode) of571

572

inSysWindow:573

begin574

SystemClick(eventRec, myWindowPtr);575

end;576

577

inMenuBar:578

begin579

DoAdjustMenus;580

menuChoice := MenuSelect(eventRec.where);581

DoMenuChoice(menuChoice);582

end;583
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584

inContent:585

begin586

if (myWindowPtr <> FrontWindow)587

then SelectWindow(myWindowPtr)588

589

else begin590

popupItem := DoCheckForControlAndValue(eventRec, myWindowPtr);591

if (popupItem <> 0) then592

DoPopupMenuChoice(popupItem);593

end;594

end;595

596

inDrag:597

begin598

DragWindow(myWindowPtr, eventRec.where, qd.screenBits.bounds);599

end;600

601

inGoAway:602

begin603

if (TrackGoAway(myWindowPtr, eventRec.where)) then604

gDone := true;605

end;606

607

end;608

{of case statement}609

610

end;611

{of procedure DoMouseDown}612

613

{ ########################################################################### DoGetMenus }614

615

procedure  DoGetMenus(myWindowPtr : WindowPtr);616

617

var618

menubarHdl : Handle;619

menuHdl : MenuHandle;620

theErr : OSErr;621

popupControlHdl : ControlHandle;622

623

begin624

menubarHdl := GetNewMBar(128);625

if (menubarHdl = nil) then626

ExitToShell;627

SetMenuBar(menubarHdl);628

DrawMenuBar;629

630

menuHdl := GetMenuHandle(mApple);631

if (menuHdl <>  nil)632

then AppendResMenu(menuHdl, 'DRVR')633

else ExitToShell;634

635

menuHdl := GetMenuHandle(mFont);636

if (menuHdl <>  nil)637

then AppendResMenu(menuHdl, 'FONT')638

else ExitToShell;639

640

menuHdl := GetMenu(hmSecondItem);641

if (menuHdl <>  nil)642

then InsertMenu(menuHdl, hierMenu)643

else ExitToShell;644

645

theErr := HMGetHelpMenuHandle(menuHdl);646

if (theErr = noErr)647

then AppendMenu(menuHdl, 'Menus Help')648

else ExitToShell;649

650

popupControlHdl := GetNewControl(pControlResID, myWindowPtr);651

if (popupControlHdl =  nil) then652

ExitToShell;653

654

DoFontMenu(gCurrentFont);655

DoStyleMenu(0);656

DoSizeMenu(gCurrentSize);657

658

end;659
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{of procedure DoGetMenus}660

661

{ ############################################################################# DoEvents }662

663

procedure DoEvents(eventRec : EventRecord);664

665

var666

theChar: char;667

668

begin669

case (eventRec.what) of670

671

mouseDown:672

begin673

DoMouseDown(eventRec);674

end;675

676

keyDown, autoKey:677

begin678

theChar := CHR(BAnd(eventRec.message, charCodeMask));679

if (BAnd(eventRec.modifiers, cmdKey) <> 0) then680

begin681

DoAdjustMenus;682

DoMenuChoice(MenuKey(theChar));683

end;684

end;685

686

updateEvt:687

begin688

BeginUpdate(WindowPtr(eventRec.message));689

EndUpdate(WindowPtr(eventRec.message));690

end;691

692

osEvt:693

begin694

HiliteMenu(0);695

end;696

697

end;698

{of case statement}699

700

end;701

{of DoEvents}702

703

{ ################################################################ start of main program }704

705

begin706

gCurrentFont := 1;707

gCurrentStyle := [];708

gCurrentSize := 2;709

710

{ ……………………………………………………………………………………………………………………………………………………………………… initialize manager }711

712

DoInitManagers;713

714

{ …………………………………………………………………………………………………………………………………………………………………………………… open a window }715

716

myWindowPtr := GetNewWindow(rWindowResource, nil, WindowPtr(-1));717

if (myWindowPtr = nil) then718

begin719

SysBeep(10);720

ExitToShell;721

end;722

723

SetPort(myWindowPtr);724

725

{ ………………………………………………………… set up menu bar and menus, then show window and pop-up menu }726

727

DoGetMenus(myWindowPtr);728

ShowWindow(myWindowPtr);729

DrawControls(myWindowPtr);730

731

{ …………………………………………………………………………………………………………………………………………………………………………………………… event loop }732

733

gDone := false;734

735
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while (not gDone) do736

begin737

if (WaitNextEvent(everyEvent, eventRec, 180, nil)) then738

DoEvents(eventRec);739

end;740

741

end.742

743

{ ###################################################################################### }744

Demonstration Program Comments
When this program is run, the user should make menu selections from all menus, including the
Apple menu, the Help menu and the pop-up menu.  Selections should be made using the mouse and,
where appropriate, the Command key equivalents.  The user should also note the effects on the
menu bar of clicking outside, then inside, the program's window, that is, of sending the
program to the background and returning it to the foreground.

The constant declaration block

Lines 59-100 establish constants relating to the pull-down and hierarchical menu IDs and
resources, menu item numbers and subitem numbers.  The constant at Line 94 represents the
resource ID of the 'CNTL' resource associated with the popup menu, and Lines 95-98 represent
the item numbers of the items in this menu.  The constant at Line 100 represents the resource
ID for the 'WIND' resource.

The variable declaration block

The global variable gDone relates to the main event loop.  When set to true, the loop will
exit and the program will terminate.  The remaining three global variables will hold the
current choices, in terms of item numbers, from the Font, Style and Size menus.

The procedure DrawItemString

The DrawItemString procedure is incidental to the demonstration, being called by the menu
selection handling functions to draw text in the application's window to reflect the user's
menu choices.  It is similar to the DrawItemString procedure in the demonstration program at
Chapter 2 — Low-Level and Operating System Events.

The function DoCheckForControlAndValue

DoCheckForControlAndValue ascertains whether a mouse-down event occurred within the pop-up
menu's control rectangle and, if so, whether the user actually chose an item from the menu.

Line 167 ensures that the window's graphics port is set as the current port.  Line 168 then
converts the contents of the event record's where field from global to local coordinates, that
is, to the coordinate system of the current graphics port.

These local coordinates are required in the call to FindControl at Line 170.  This call
establishes whether the event occurred in the popup menu control or elsewhere in the content
region.  If an active control was located at the point specified in its first parameter,
FindControl will receive a handle to that control into its third parameter and return a part
code, otherwise it will return 0.

If an active control is detected, it can be safely assumed in this program that it is the pop-
up menu's control. (The window contains no other controls.)  Accordingly, the control's
current value is saved at Line 172 preparatory to handling over control to TrackControl at
Line 173.  TrackControl tracks user action until the mouse button is released and returns an
integer which we ignore.

Note the third parameter of the TrackControl call.  The pop-up menu control definition
function contains code which is referred to as an "action procedure", and which is invoked
repeatedly as long as the mouse button remains down.  This action procedure will not be
invoked unless TrackControl's third parameter, in calls relating to pop-up menus, is set to
-1, cast to be of type ControlActionUPP.  (Action procedures are addressed at Chapter 5 —
Controls, and action procedures within control definition functions are addressed at Chapter
19 — Custom Control Definition Functions and VBL Tasks.)

On release of the mouse button, Line 174 gets the control's new value.  This will only have
been changed by the pop-up control definition function if the user did not release the mouse
button with the cursor outside the menu and if the user actually chose a new menu item.  If
the control's value before and after the TrackControl call differs, Line 178 causes the
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control's new value to be returned to the calling function.  (For pop-up menus, the control's
value equates to the item number of the menu.)  If there is no difference, Line 179 returns
zero to the calling function, which will defeat the calling by that function of further
application-defined pop-up menu handling functions.

The procedure DoAdjustMenus

DoAdjustMenus is called when a mouse-down occurs in the menu bar and when examination of a
key-down event reveals that a menu item's keyboard equivalent has been pressed.  No action is
taken in this simple program because only one window, whose content never changes, is ever
open.

(Later demonstration programs contain examples of menu adjustment functions which cater for
specific circumstances.  For example, the menu adjustment function in the demonstration
program at Chapter 6 — Dialogs and Alerts accommodates the situation where the front window
could be either a document window, a movable modal dialog box, or a modeless dialog box.)

The procedure DoPopupMenuChoice

DoPopupMenuChoice branches according to the integer returned by GetControlValue, which
represents the popup menu item number chosen by the user.  This function completes the popup
menu handling in this demonstration.

The procedure DoAppleMenu

DoAppleMenu takes the short integer representing the menu item.  If this value represents the
first item in the Apple menu (the inserted "About…" item), text representing this item is
drawn in the scrolling display (Lines 236-237).

If the value passed to DoAppleMenu represents other items in the Apple menu (Line 239), the
call to GetMenuItemText at Line 240 gets the string representing the item's name.  This string
(which excludes metacharacters) is used as the parameter in the OpenDeskAcc call at Line 241.
OpenDeskAcc opens the chosen object and passes control the chosen object.

The procedure DoFileMenu

DoFileMenu handles selections from the File menu.  In this demonstration, only the Quit item
is enabled, all other items having been disabled in the File menu's 'MENU' resource.  When
this item is chosen, the global variable gDone is set to true (Line 253), causing termination
of the program.

The procedure DoEditMenu

DoEditMenu branches according to the menu item number, drawing text representing the chosen
item in the window.

The procedure DoFontMenu

DoFontMenu first gets a handle to the Font menu record (Line 305) required by the CheckItem
calls at Lines 307-308.  The CheckItem calls uncheck the current font menu item and check the
menu item passed to DoFontMenu.  This latter menu item number is then assigned to the
gCurrentFont global variable (Line 310).

The call to GetMenuItemText at Line 312 extracts the string representing the item's name.
This string is passed as the first parameter in the call to GetFNum (Line 313), which gets the
font number associated with the name.  This number is then used in the call to TextFont at
Line 314, which will cause subsequent text drawing to be conducted in the specified font.
Line 316 draws the name of the font in that font

The procedure DoStyleMenu

DoStyleMenu branches according to the menu item chosen in the Style menu.  Lines 331-370 cause
the items in the global set variable gCurrentStyle to be added or removed according to the
font styles selected.  Note that in Pascal the Style type is defined as

StyleItem = (bold,italic,underline,outline,shadow,condense,extend);
Style = set of StyleItem;

and so must be manipulated as a set.  The code reflects the fact that Bold, Italic, Underline,
Outline and Shadow style selections are additive, not mutually exclusive, and that a selection
of Plain must remove all elements of gCurrentStyle.  The code also reflects the requirement
that, except in the case of the Plain item, the selection of a checked item must cause that
item to be unchecked, and vice versa.
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With the appropriate inclusions/removals in gCurrentStyle attended to, a handle to the Style
menu record is then obtained (Line 373).  This is required for the CheckItem calls at Lines
375-380, which check or uncheck the individual menu items according to whether the third
argument evaluates to, respectively, true or false.

At Line 382, the call to TextFace sets the style for subsequent text drawing.  Line 386 draws
some text to prove that the desired effect was achieved.

The procedure DoSizeMenu

DoSizeMenu branches according to the menu item chosen in the Size menu, sets the text size for
all text drawing to that size (397-418), unchecks the current size item (Line 423) and checks
the newly selected item (Line 424).  gCurrentSize is set to the selected menu item number
(Line 426) before the function returns.

The procedure DoSpecialMenu

DoSpecialMenu handles a selection of the first item in the Special menu.  Since the second
item is the title of a submenu, only the first item is attended to in this function.

The procedure DoSubMenus

DoSubMenus branches according to the chosen subitem in the hierarchical menu represented by
the second menu item in the Special menu.

The procedure DoHelpMenu

DoHelpMenu handles the selection of the "Menus Help" item added by this program to the system-
managed Help Menu.  This code reflects the fact that Apple reserves the right to add items to
the Help menu in future versions of the system software.

At Line 475, HMGetHelpMenuHandle gets a handle to the Help menu record.  At Line 483, the call
to CountMItems returns the number of items in the Help menu.  Since we know that we have added
one item to this menu, Line 484 will establish the original number of help items.  If the
value passed to the doHelpMenu function is greater than this (Line 486), it must therefore
represent the item number of our "Menus Help" item, in which case some text is drawn in the
window to register the fact (Line 487).

The procedure DoMenuChoice

DoMenuChoice takes the long integer returned by the MenuSelect and MenuKey calls, extracts the
high word (the menu ID) and the low word (the menu item number) and switches according to the
menu ID.

At lines 499-500, the menu ID and the menu item number are extracted from the long integer.
Lines 502-503 will cause an immediate return if the high word equals 0, (meaning that either
the mouse button was released when the pointer was outside the menu box or MenuKey found no
menu list match for the key pressed in conjunction with the Command key).

Lines 505-552 branch according to the menu ID, calling the appropriate application-defined
individual menu handling function.  Note the handling of the hierarchical menu at Lines 542-
545.  Note also that, at Line 547, the kHMHelpMenuID constant (-16490) is returned in the high
word if the user chooses an appended item from the Help menu.

MenuKey and MenuSelect leave the menu title highlighted if an item was actually selected.
Accordingly, Line 555 unhighlights the menu title when the action associated with the user's
drop-down menu choice is complete.

The procedure DoMouseDown

DoMouseDown first establishes the window and window part in which the mouse-down event
occurred (Line 569), and branches accordingly.  This demonstration program is specifically
interested in mouse-downs in the menu bar and the content region of the window, the latter
because the pop-up menu is located in the window.

Lines 574-576 pass mouse-downs in a system window to SystemClick for further handling.

If the event occurred in this program's menu bar (Line 578), menu enabling/disabling is
attended to (Line 580) before the call to MenuSelect (Line 581).  MenuSelect tracks the user's
actions until the mouse button is released, at which time it returns a long integer.  If the
user actually chose a menu item, this long integer contains the menu ID in the high word and
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the item number in the low word, otherwise it contains 0 in the high word.  At Line 582, this
long integer is passed to the DoMenuChoice procedure.

If the mouse-down event occurred in the content region of the window (Line 585), and if the
window to which the mouse-down refers is not the front window, SelectWindow is called to
effect basic window activation/deactivation (Lines 587-588).  If, however, the window
receiving the mouse-down is the front window, Line 591 calls an application-defined function
which checks whether the cursor was within the pop-up's control rectangle and, if it was,
returns the control's value if the user actually chose a pop-up menu item.  If the user
actually chose a pop-up menu item (that is, if the received value was non-zero), the control's
value is passed to an application-defined function which handles the choice (Lines 592-593).
(The control's value equates to the chosen menu item's number.)

Lines 598-600 respond to a mouse-down in the drag bar.  Not that, if the window is dragged to
a new position, the pop-up menu will be redrawn automatically, together with the window, with
no assistance from the program.

Lines 603-605 respond to a mouse-down in the go-away box, setting gDone to true and thus
terminating the program if the cursor is still within the go-away box when the mouse button is
released.

The procedure DoGetMenus

DoGetMenus sets up the menu bar and the various menus.

At Line 625, GetNewMBar reads in the 'MENU' resources for each menu specified in the 'MBAR'
resource and creates a menu record for each of those menus.  (Note that the error handling
here and in other areas of this program is somewhat rudimentary: the program simply terminates
(Lines 626-627).)  At Lines 628-629, SetMenuBar makes the newly created menu list the current
list and DrawMenuBar draws the menu bar.

Lines 631-634 add the contents of the Apple Menu Items folder to the Apple menu.  The use of
'DRVR' as the second parameter to the AppendResMenu call is automatically interpreted to mean
that the Apple menu is being created, so that all items in the Apple Menu Items folder are
added rather than resources of type 'DRVR'.

Lines 636-639 add the names of all resident fonts to the Font menu.  Using 'FONT' in the
second parameter in the call to AppendResMenu causes all such resources to be searched out and
their names added to the specified menu.

Lines 641-644 insert the application's single submenu into the submenu portion of the menu
list.  GetNewMBar does not read in the resource descriptions of submenus, so the first step is
to read in the 'MENU' resource with GetMenu.  InsertMenu inserts a menu record for this menu
into the menu list at the location specified in the second parameter to this call.  Using the
constant hierMenu (-1) as the second parameter causes the menu to be installed in the submenu
portion of the menu list.

Lines 646-649 append a menu item with the name "Menus Help" to the Help menu.

Line 651 sets up the popup menu.  GetNewControl loads the specified 'CNTL' resource into a
control record and creates the control in the specified window.  (The 'CNTL' resource
specifies popUpMenuProc in the procID field, so the control is created as a popup menu.  The
Min field of the 'CNTL' resource description contains the 'MENU' resource ID for the popup
menu, which ensures that the GetNewControl call will load the popup menu resource and create a
menu record in the submenu portion of the menu list.)

Lines 655-657 set checkmarks against the appropriate font, style and size menu items according
to the initialised values of the associated global variables.

The procedure DoEvents

DoEvents branches according to the type of low-level or Operating System event received.
Further processing is called for in the case of mouse-down or Command key equivalents, these
being central to the matter of menu handling.

In the case of key-down and auto-key events, the character code is first extracted from the
event record's message field (Line 679).  A check is then made of the modifiers field to
establish whether the Command key was also pressed at the time (Line 680).  If so, menu
enabling/disabling is attended to (Line 682) before the call to MenuKey (Line 683) establishes
whether the character code is associated with a currently enabled menu or submenu item in the
menu list.  If a match is found, MenuKey returns a long integer containing the menu ID in the
high word and the item number in the low word, otherwise it returns 0 in the high word.  This
long integer is then passed to the DoMenuChoice procedure.
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The call to HiliteMenu at Line 695 is made to unhighlight the Apple menu title when the user
brings the demonstration program to the foreground having previously sent it to the background
by choosing an Apple Menu Items folder item from the Apple menu.

The main program block

This initialises the system software managers (Line 713), creates a window and makes its
graphics port the current port (Lines 717-724), calls the application-defined function which
sets up the menus (Line 728), shows the window and pop-up menu (Lines 729-730) and enters the
main event loop (Lines 736-740).

Creating 'MBAR'  and 'MENU'  Resources Using ResEdit

When learning to create the major resource types in ResEdit, it is recommended that you open
Macintosh C to the page containing the relevant example resource definition in Rez input format and
relate what you are doing within ResEdit to that definition.  Accordingly, the methodology used in the
following is to "walk through" the 'MBAR' and 'MENU' resources for the Menus demonstration program,
relating what you see in ResEdit to the example definitions in this chapter.

Open the chap03pascal_demo demonstration program folder and double-click on the Menus.µ.rsrc icon
to start ResEdit and open Menus.µ.rsrc.  The Menus.µ.rsrc window opens.

'MBAR'  Resources

Double-click the MBAR icon.  The MBARs from Menus.µ.rsrc  window opens.  One 'MBAR' resource (ID
128) appears in the list in the window.  Double-click that list entry.  The MBAR ID = 128 from
Menus.µ.rsrc window opens.

The following relates the example 'MBAR' resource in Rez input format in this chapter to the ResEdit
display and interface:

resource 'MBAR' This was established when the resource was created by choosing
Resource/Create New Resource.  A small dialog opened, the item MBAR was
clicked, and the dialog's OK button was clicked.

(rMenuBar, Choose Resource/Get Resource Info.  The Info for MBAR 128 ... window
opens.  Note the editable text text item ID:.  (ResEdit automatically assigns 128
as the ID of the first 'MBAR' resource you create.)

preload) Also note, in the Attributes section, that the Preload checkbox is checked.
Close the Info for MBAR 128 ... window.

mApple
mFile
mEdit

Back in the MBAR ID = 128 from Menus.u.rsrc window, note entries 1), 2), and
3).

MENU resource IDs are added by clicking on the next entry number (e.g.,
8) *****), choosing Resource/Insert New Field, and entering the resource ID at
the associated Menu res ID editable text item.

MENU resources may be deleted by clicking the entry number (e.g. 8) *****)
and choosing Edit/Cut.

Close the MBAR ID = 128 from Menus.µ.rsrc window.  Close the MBARs from Menus.µ.rsrc window.

'MENU' Resources

Double-click the MENU icon.  The MENUs from Menus.µ.rsrc window opens.  Double-click the Apple
menu icon ('MENU' resource ID 128).  The MENU ID = 128 from Menus.µ.rsrc window opens.

The following relates the example 'MENU' resource in Rez input format in this chapter to the ResEdit
display and interface:
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resource 'MENU' This was established when the resource was created by choosing
Resource/Create New Resource.  A small dialog opened, the item MENU was
clicked, and the dialog's OK button was clicked.

(mApple, mApple is the resource ID (128).  Choose Resource/Get Resource Info.  The
Info for MENU 128 ... window opens.  Note the editable text item titled ID:.
This is where you set the resource ID.  ResEdit automatically assigns 128 as the
resource ID of the first 'MENU' resource you create.

preload) While the Info for MENU 128 ... window is open, compare the Attributes
check boxes to the Resource Attributes table at Chapter 1.  Note that the
Preload checkbox is checked.

mApple Close the Info for MENU 128 ... window and  choose MENU/Edit Menu & MDEF
ID.  A dialog box opens.  Note the editable text item titled Menu ID.  Note that
the Menu ID is the same as the 'MENU' resource ID displayed in the Info for
MENU 128 ... window.  ResEdit automatically makes the MENU ID the same as
the 'MENU' resource ID, although you can assign a different MENU ID here if
you want to.

textMenuProc Also note that 0 appears in the editable text item titled MDEF ID.  This means
that the standard menu definition procedure is specified.  Choose Cancel to
close the dialog.

0b11111111111 ... At the left of the MENU ID = 128 ... window, click, in turn, on the About
Menus... item and the separator-line item, and observe the checkbox titled
Enabled at the right of the window.

enable Click on the menu title (the apple icon) and observe the checkbox titled
Enabled at the right of the window.

apple Click on the menu title (the apple icon) and note the radio button titled Apple
menu under the editable text item at the right of the window.

"About ... " Click on the About Menus... item in the list at the left of the window and note
that you can edit this in the editable text item at the right of the window.

noIcon Choose MENU/Choose an Icon.  A Choose an icon ... dialog opens.  (Simply
note this for now.  The matter of icons in menu items is addressed at Chapter
12).  Close the dialog.

noKey Note the small editable text item titled Cmd-Key at bottom right.  This is
where you enter the Command key equivalent for a menu item.

noMark Note the popup menu titled Mark at bottom right.  This is where you can
specify the mark to be inserted into the menu item.

plain Open the Style menu.  (Note that this menu has been used to set the style of
the items in the Style  menu ('MENU' resource ID 132).

- Click on the separator-line item and note the radio button titled (separator
line) under the editable text item at the right of the window.

noIcon
noKey
noMark
plain

(As above)

Note that, when you click on the menu's title at the left of the window, three Color pop-ups appear at
the bottom right  of the MENU ID = ... window.  If you use these pop-ups to specify colours for the title,
item text and/or background, ResEdit automatically creates a 'mctb' (menu color table) resource with
the same resource ID as the associated 'MENU' resource.

Hierarchical Menu

At the example hierarchical menu resource in Rez input format in this chapter, note the line beginning
Label Style and the following description of the associated submenu.
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With the MENUs from Menus.µ.rsrc window open, double click the Special menu icon ('MENU' resource
ID 134).  The MENU ID = 134 ... window opens.  Click on the item Second Item.  Note that the has
Submenu checkbox is checked and that the ID: box shows an ID of 100.

Close the MENU ID = 134 ... window.  In the MENUs from Menus.µ.rsrc window, note the 'MENU'
resource with ID 100.  Also note that the name of the menu item Second Item is also the title of the
'MENU' resource with ID 100.

Pop-up Menu

With the MENUs from Menus.µ.rsrc window open, note the 'MENU' resource with ID 135.

The matter of 'CNTL' resources for pop-up menus is addressed at Chapter 5 — Controls.
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